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1 INTRODUCTION

1 Introduction

1.1 Contact

igus® GmbH

Spicher Str. 1a

D-51147 Köln

Tel.: +49(0)2203 / 96498-255

E-Mail: ww-robot-control@igus.net

Internet: www.igus.eu
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1 INTRODUCTION

1.2 Intended Use

The intended use of the product is defined by the uses within the defined limits from the technical
data. The permissible electrical parameters and the defined permissible ambient conditions must be
observed in particular. These are specified in more detail later in this manual.
The intended use for this product can be found in the following section 3.

1.3 Target Group and Qualification

The product and this documentation are intended for technically trained professionals such as:
• development engineers
• plant designers
• assemblers/service personnel
• application engineers

Installation, commissioning, as well as operation is only allowed by qualified personnel. These are
persons who meet all the following requirements.

• have appropriate training and experience in handling motors and their control.
• know and understand the contents of this technical manual.
• know the applicable regulations

1.4 Symbols Used

All notes in this document follow a consistent form and are structured according to the following
classes.

,
The WARNING notice alerts the reader to possible dangerous situations.
Disregarding a warning can possibly result in moderate injury to the user.

• Within a warning, this describes ways to avoid hazards.

ð
This note indicates possible incorrect operation of the product.
Failure to comply with this notice may possibly result in damage to this product
or other products.

1.5 Product Safety

The following EU directives were observed:
• RoHS-Directive (2011/65/EU, 2015/863/EU)
• EMV-Directive (2014/30/EU)

1.6 Regulations

In addition to this technical manual, operation, commissioning is subject to the applicable local reg-
ulations, such as:

• Accident prevention regulations
• Local regulations for occupational safety

©2023 igus® GmbH 5



2 SYSTEM OVERVIEW

2 System Overview

The robot controller described here is part of a robot system that consists of four basic components:

1. Robot: the mechanical robot arm

2. Robot control: modular robot controller consisting of embedded computer, motor driver mod-
ules for controlling the robot axes and IO modules.

3. Robot control software: Control software for moving the robot and executing robot programs.

4. Programming environment: Graphical software for setting up robot programs

The robot controller is used to control the movement of the robot’s motors. The robot controllers
are available with 48V motor voltage or 24V motor voltage. The stepper motor driver modules are for
bipolar stepper motors of different sizes and configurable, or preconfigured. For precise positioning
and control, quadrature encoder signals are normally read in, which feed back the actual motor or
axis position to the stepper motor driver modules. In addition, different referencing methods and
movements are supported to transmit the "actual position" of the robot to the software after a cold
start of the robot system. Different inverse kinematics are supported in the software, so that e.g.
controlled linear movements of a robot arm are as easy to program as those of a gantry robot.

2.1 Specifications

Modular Control Feature
Power supply 24V

Type DIN rail modules with 5-pole bus connector

Communication with PC/PLC CRI or Modbus via Ethernet

Internal communication CAN

Joint modules Closed Loop motor modules

absolute encoder

integrated brake

Digital In/Out Base: each 7 digital in/outputs

solid state relay, 24V level, max 500 mA

Digital In/Out Arm: each 2 digital in/outputs

solid state relay, 24V level, max 500 mA

Table 2: Modular Robot Control - Components

The features of the embedded control can be seen in the table 3.

Embedded control Features
Type Single board computer with daughter module

Operating system Linux based

Software TinyCtrl robot control software

Interfaces CAN Bus (connection to the modules)

Ethernet (connection to Windows PC)

©2023 igus® GmbH 6



2 SYSTEM OVERVIEW

Embedded control Features
USB

RS232 display connection

Digital inputs for enabling switch

DC/DC converter 5V/4A

Table 3: Integrated Computer - Specifications

2.2 Mechanical Dimensions

For mechanical dimensions, please refer to the data sheet of the ReBeL.
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3 SAFETY INSTRUCTIONS

3 Safety Instructions

,
Operate the robot carefully!
When operating a robot arm or commissioning a robot cell, always pay attention to the
personal safety of the users and other persons! In particular, there must be no persons
or obstacles in the working area of the robot.

• In the basic version, the robot control package does not contain any safety-related functions.
Depending on the application, these may have to be added. See also "CE marking" below.

• CE marking: The robot arm and robot controller are part of a system that must be risk assessed
in its entirety and comply with the applicable safety regulations to ensure personal safety. De-
pending on the outcome of the assessment, other safety components may need to be inte-
grated. These are usually safety relays and door switches. The engineer commissioning the
system is responsible.

• Depending on the equipment, the robot controller contains one or more 24V or 48V power
supplies up to 10A, which themselves require mains voltage (120 V / 240 V) depending on the
configuration. Please check the label on the power supply. Only qualified personnel may con-
nect the power supply to the mains and put it into operation.

• Work on the robot electronics should only be performed by qualified personnel. Check the
guidelines for electrostatic discharge (ESD).

• Always disconnect the robot controller from the mains (120 V / 240 V) when working in the
control cabinet or on electronics connected to the robot controller.

• DO NOT hot plug! This can cause permanent damage to the motor modules. Do not install
or remove any modules or connectors (e.g. manual control unit, emergency stop switch, DIO
modules or external relays, motor connections...) while powered up.

• The robot arm must be set up on a robust surface and screwed down or otherwise secured.
• Use and store the system only in a dry and clean environment.
• Use the system only at room temperature (15° to 32°C).
• The ventilation of the system must be able to work unhindered to ensure sufficient air flow for

cooling the stepper motor modules. There must be at least 10 cm of space next to the fan of the
robot controller. The fan must ideally point upwards or to the side (reduced efficiency). The fan
must not point downwards.

• Save important data before installing the iRC - igus Robot Control.

©2023 igus® GmbH 8



4 REQUIREMENTS

4 Requirements

4.1 Environmental Conditions

Ambient conditions Wert
Protection class IP20

Ambient temperature (operating) +10. . . +32°C

Ambient temperature (storage) -10. . . +85°C

Humidity (non-condensing) 0. . . 90%

Installation height above sea level (without power restriction) 1500m

Table 4: Ambient conditions

4.2 Software Requirements

To use iRC a computer with the following features is required:
• PC (min. Intel i5 CPU) with Windows 10 or 11 (64 Bit)
• .NET Framework 4.7.2 or newer
• at least 500MB free disk space
• graphics card (integrated or dedicated)

– OpenGL 3.0 or newer
– manufacturer driver (the standard Microsoft driver is not supported)

• a free Ethernet port

©2023 igus® GmbH 9



5 QUICK START GUIDE

5 Quick Start Guide

5.1 Set up and Connect

,
Before Starting the Work
To avoid injuries as well as damage to the components, observe the following
instructions:

• Follow the safety instructions in section 3.
• Disconnect the robot or the controller from the mains. Never work on

live parts. Work on control cabinets may only be carried out by qualified
electricians.

• No hot plugging! Before plugging in or disconnecting modules/plugs/-
electrical connections, disconnect the controller/robot from the mains.

• Ensure a safe stand of the robot and the controller.
• Observe the requirements for the environment 4.1.
• During the movements of the robot, no persons may be in the working

area of the robot.

To set up and commission the robot, proceed in the following order:

1. Make sure that the controller is disconnected from the power supply: Unplug the power cord.

2. Mount the robot on a suitable base. Make sure that the cables are not under tension.

3. Feed the robot cables through the large circular hole in the control cabinet and plug them into
the stepper motor modules. Each motor with its associated reference sensor is connected to
its stepper motor module via 4 connectors (see Fig. 3). All connectors are labeled and coded to
support this process. The following cables each belong to a motor the affiliation between motor
and cable set is also numbered on the connectors:

• motor cable (with the designation motor)
• encoder cable (2 connectors labeled ENC-1 and ENC-2)
• reference sensor (labeled End-Stop)

4. Connect the shield and ground wires of the encoder and motor cables, if present.

• motor cable ground: green-yellow
• encoder shield (ground): black

5. All motor and encoder cable ground wires are plugged into the ground block next to the con-
troller.

6. Secure the robot cables against voltage, e.g. with a cable tie to one of the holes in the control
cabinet. If present, plug in the teach pendant cable and secure it via the screw connection.

7. The robot is ready to be switched on after completing these steps.

©2023 igus® GmbH 10



5 QUICK START GUIDE

5.2 Switch On

,
Danger of Electric Shock! Before commissioning the components, make sure
that all cables and control cabinet components are properly connected. Check
all cables for tight fit and make sure that there are no loose cables in the control
cabinet.

1. Connect the robot to your power supply using the enclosed power cable.

2. Switch on the robot using the On/Off switch on the control cabinet.

3. The green light emitting diodes (LEDs) on the modules will now light up, as will most of the red
LEDs and possibly some of the yellow LEDs.

4. After the control computer has finished booting (after about 60s), the green LEDs will start
flashing. This indicates communication with the modules. Now the robot controller is in oper-
ation. If available, you can now move the robot via the optional handheld operating device (see
section ??).

5.3 Connecting and moving the robot

5.3.1 Preparation with the integrated computer

The following steps establish the LAN connection between the robot controller and the Windows PC.

1. Connect your PC to the robot controller using an Ethernet cable. Use the Ethernet port located
right next to the USB socket on the integrated computer of the robot.

2. Set the IP address of the PC to: static and 192.168.3.1 with a subnet mask of 255.255.255.0.
Instructions for changing the IP address of your computer can be found on the Internet under
the keyword "Change IP address Windows 10"..

5.3.2 Moving the Robot for the First Time

1. Install the iRC software on your PC.

2. Start the iRC software. At startup, you can select the project that applies to your robot. Please
refer to the product number or product name, the project names are based on these (see Fig.
1).

3. You can now activate the robot by pressing the following buttons in the given order (see also
Fig. 2):

3.1 "Connect"

3.2 "Reset"

3.3 "Enable"

�
Wait a few seconds after activation before moving the axes or starting a program.
The axes release their brakes and align themselves before they can be moved. You
may hear clicking noise during this process.
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Figure 1: Choosing a project

Figure 2: Jog Commands
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4. Now the status LED light on the left in iRC should be green and the status should show "No
Error".

5. You can now move the robot’s joints using the buttons on the "Jogging" tab (see Fig. 2).

©2023 igus® GmbH 13
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6 Moving the Robot with iRC

iRC - igus Robot Control is a control and programming environment for robots. The 3D user interface
helps to get the robot up and running quickly. Due to the modular structure, different kinematics and
motor drivers can be controlled.

6.1 The Graphical User Interface

This section explains the iRC software. All steps can be simulated even without a robot connected. In
section 6.2 the real robot is then connected and moved.
The programming environment iRC enables the control and programming of the robot. You can work
both online and offline, i.e. with the robot or in simulation (with the robot switched off or not con-
nected).

Figure 3: User interface of the iRC - igus Robot Control

In the upper left corner, the three tabs "File", "Scene", "Motion" and "Help" provide access to the
main functions. In the left corner, information about the current state of the physical robot is dis-
played. Additional functions like loading another project ("Open Project") or "Robot Referencing"
can be found in the "File" tab (see Fig. 3).
There are seven tabs at the bottom of the window:

• "Log messages": Messages from the program about status or errors.
• "Infocenter": displays the axis values, Cartesian position and other information.
• "Jogging": keys to move the robot.
• "Input/Output": Display and set the DIO interfaces of the robot controller.
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• "Programs & Variables": displays the current values of the program variables.
• "Cameras": Images of the connected cameras and detected object positions.
• "Statistics": Statistics about the system and the running robot program.

The "Help" icon in the lower right corner contains links to the wiki pages ("Online Doc-
umentation", "Software Updates", "Examples", "Troubleshooting") and a link to "Con-
tact Support". The log files of iRC and the integrated controller can also be accessed
here.

6.1.1 Selecting the type of robot

iRC provides project-related settings for different robot types, such as gantries, robot arms or delta
robots. Figure 4 shows the project open area, which can be used to load the corresponding project.

1. Click on the "File" tab in the upper left corner and select "Open Project".

2. Select the robot group, e.g. "robolink".

3. Make sure that the parameter set matching the operating voltage of the robot is selected. This
will affect the speed and acceleration.

4. Now click on the entry that matches your robot, e.g. RL-DP-5.

Figure 4: Selection of the robot type via the menu item "File" → "Open Project"
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6.1.2 Navigation and movement of the robot in the 3D view

A 3-button mouse is recommended for navigating in the iRC - igus Robot Control 3D environment:
• Left button:

– Selecting icons and functions in the menu.
– Moving a robot axis: Place the cursor over a joint (it will be highlighted), then click and

move the cursor up and down while holding down the left mouse button.
• middle button/mouse wheel:

– Navigate the scene to rotate the robot: Move the cursor while holding down the middle
mouse button.

– Mouse wheel rotation: Zoom in/out to the current cursor position.
• Right button: move the image section.

The function of the left mouse button can be changed
in the "Scene" tab under "Navigate". The movement
options "Select", "Move", "Rotate" and "Zoom" are
available. "Reset" returns you to the home screen.

6.2 Connecting the robot

6.2.1 Hardware connection

The real robot can be controlled in the same way as the simulated one, only the hardware must first
be connected and activated by clicking the "Connect", "Reset" and "Activate" icons in the "Physical
Robot" button group in the "Motion" tab (see Fig. 5). After that, the robot must be referenced.

Figure 5: Buttons for connecting to the hardware, resetting errors and activating the motors, refer-
encing and "Status" display.

1. "Connect": Establish the connection to the hardware.

• This initializes the connection (mostly via Ethernet, in some cases via USB CAN adapter).
• The "Status" indicator on the left side changes from gray to red.
• Several error messages are displayed below the "Status" indicator.

2. "Reset": Resets the errors.

• This key is used to reset the error memories of the electronic modules of the robot con-
troller.
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• The axis positions are transferred from the real robot to the simulation environment. The
3D visualization of the robot should now correspond to the current position of the real
robot.

,
This must be checked with every error reset! If the values do not match,
referencing must be performed, which is described in section 6.3.

• The "Status" display remains red. The error messages are cleared, only "Motors not en-
abled" remains. If other error messages are displayed, try again and follow the instructions
in the robot documentation.

3. "Activate": Activation of the motors.

• The "Status" indicator is now green.

6.2.2 Move the robot

It is now possible to move the robot using the jog keys, a mouse in the user interface or a gamepad,
see section 6.4.

6.3 Referencing the robot

, • After startup, the robot must be referenced. Before referencing, the robot’s axes
can only perform motions in joint mode. This is to avoid collisions during unref-
erenced robot operation.

• Cartesian movements or the start of a program are only possible after referencing.
• The status is displayed on the left side of the iRC - igus Robot Control.

The motor modules store the position in an EEPROM. However, due to gravity or other forces, the axes
may move when the motor power is switched off. In this case, the motor modules no longer report
the correct position to the software. In order to synchronize the position between software, stepper
motor module and robot axis, referencing must be performed.

6.3.1 Step by step guide of referencing

1. Start the robot controller and the iRC - igus Robot Control.

2. Press the buttons "Connect", "Reset" and "Activate" (see fig. 5).

3. Click the "Reference" button (Fig. 5) in the button group "Physical Robot" in the "Motion" tab
(or "Robot Reference" in the "File" tab) to open the referencing window.

4. Click on the "Reference Axis" buttons to start referencing an axis, see Fig. 6. Multiple joints can
perform referencing in parallel.

5. You can also click on "Reference all", then the axes will start referencing in an order defined in
the project file.

6. Once all movements have been executed and the robot is at rest again, click on "Reset" and
"Activate". Now the robot is fully functional.
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Figure 6: Referencing of the axes.

6.4 Moving the robot

The robot can be moved manually (or "jogged") when no program is running. The following options
are available for this purpose:

• Software keys
• dragging joints in 3D area
• gamepad

The most important settings can be found in the "Movement" tab (see Fig. 7):
• "Input": Connecting a gamepad
• "Motion parameters": Selection of movement modes and speed

Figure 7: Control panels for moving the robot (highlighted in blue).

6.4.1 Gamepad

A gamepad is possibly the most intuitive way to move the robot. The fig. 8 shows the key assignment.
Pressing "Connect Gamepad" will connect iRC to a gamepad. If the connection is successful, an OK
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sign will be displayed under the icon. The device must be of type "Joystick" or "Gamepad". For more
information about the connection, see the "LogMessages" tab (at the bottom of the window area).
By default, the following key assignment is given, whereby the functions marked with (*) are only
available from V13-031. The movement speed can be changed in older versions via the right thumb-
stick (horizontal). The direction of the axes depends on the robot type.

Figure 8: Key assignment of the gamepad

1. • top: Change motion mode
• bottom: Decrease speed (*)

2. • top: Change key assignment: Switch between X, Y, Z and A, B, C in Cartesian motion mode
or A1, 2, 3 and A4, 5, 6 in axis motion mode.

• bottom: Increase speed (*)

3. • up: select previous statement in program editor (*)
• down: select next statement in program editor (*)

4. • top: Touch up the current statement in the program editor (*)
• right: add axis movement to program instruction
• bottom: Add linear motion program statement
• left: Remove selected instruction in program editor (*)

�
Starting with version V13-031 the assignment of the gamepad can be changed via the
project configuration file, see:

https://wiki.cpr-robots.com/index.php/Joystick_a
nd_Gamepad

6.4.2 Software Buttons

Software buttons allow the selection of the motion mode. Three modes are available, each of which
allows the movement speed to be changed between 0 and 100% (Fig. 7):

• "Axis": Clicking on A1 to A6 moves the corresponding robot axis (if present). E1 - E3 moves the
external joints. This may be a linear or a rotational axis (9).

• "Base" (Cartesian mode) moves the robot in straight lines along the X, Y, and Z axes of the base
coordinate system.

• "Tool": (Cartesian mode) moves the robot in X, Y and Z of the current tool coordinate system.
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Figure 9: The software buttons for "axis" movements. In both Cartesian modes, the buttons change
to X, Y, Z, A, B and C.

6.5 Unreachable Positions and Singularities

In axis mode each axis can move in its full range of motion (provided it does not collide). Some
positions may not be reachable in cartesian mode depending on the kinematics. In some cases this
is due to mathematical peculiarities, for example small movements with an extended robot arm can
lead to fast axis movements or an ambiguous orientation - this is called singularity.
Among others, the following positions are not reachable:

• Out of Reach: the target position is too far away or cannot be reached by the kinematics. For
robot arms, the motion stops before the arm is fully extended.

• Center Singularity: Occurs with robot arms when the arm is close to the center axis (rotation
axis A1).

• Wrist Singularity: Occurs on 6-axis robot arms when the wrist (last 3 axes) is extended too far.
If the robot comes close to such a position in cartesian mode the motion will be stopped and a pos-
sibly running program will be interrupted. The status area on the left of iRC indicates the kinematic
error.

�
To avoid singularities joint motion can be used instead of cartesian motion (e.g. linear
command). This is especially useful for dynamic target positions, e.g. from a camera

.

6.6 Starting robot programs

A robot program can be loaded and started as follows:

1. To load the program, click on the "Open" folder icon in the "Selected program" group of the
"Movement" tab and select a program, e.g. "testRobolink.xml".
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Figure 10: Loading a program (highlighted in blue).

2. Set the basic speed:

• Before starting an untested program, set the
speed to e.g. 20%.

• Be especially attentive during the first complete
program run and have the emergency stop key
ready.

3. Start the program:

• Click the "Execute" icon in the "Program Exe-
cution" button group of the "Motion" tab.

4. Pause or interrupt the program:

• After pressing the "Pause" icon, the robot can continue with the program by clicking the
"Run" icon again.

• After pressing the "Stop" icon, the program will start with the first command when the
"Run" icon is clicked again.

• The "Play" mode can be set to three different values:
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– Once (the program stops after a single cycle).
– Repeat (the program stops only by "Stop" or "Interrupt").
– Single step (this is useful for debugging a program).

6.7 Digital inputs and outputs

The status of the inputs and outputs can be monitored under "Inputs/Outputs". Both inputs and
outputs can be manually activated or deactivated:

• Outputs can be set manually when no program is running.
• Inputs can only be set in simulation when no robot is connected. So you can test the reaction

of programs to different inputs even without the corresponding hardware.

Figure 11: Input/output area of the iRC - igus Robot Control.

The configuration of the inputs and outputs is described in section 8.1.

6.8 Software interfaces

The robot controller provides various interfaces:
• PLC interface for control via the digital inputs and outputs. Especially for easy starting and

stopping of programs via a PLC or pushbutton.
• Modbus TCP interface for control via a PLC or PC.
• CRI Ethernet interface for control and configuration via a PLC or PC. This interface offers the

widest range of functions, but requires individual implementation.
• ROS interface for operating the robot via the Robot Operating System (www.ros.org).
• Interface for object detection cameras.
• Cloud interface for monitoring the robot state.

See section 9.2 for the configuration of these interfaces.

6.9 Updating the software

Updates of the iRCsoftware can be found at the following address: https://wiki.cpr-robots.co
m/index.php/IgusRobotControl-EN.

,
Create a backup because files can be overwritten during the update!
Rename your old iRC-Folder (z.B. C:\iRC-igusRobotControl) before starting the instal-
lation. This way you can go back to the old version.

The following may need to be copied from the previous installation:
• The created robot programs
• Changes in the project or in the robot configurations.
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7 Programming a Robot with iRC

The iRC - igus Robot Control enables the creation of robot programs. The method of programming is
called "teach-in programming", which works as follows:

1. Move the robot manually to the position you want to record.

2. Record the position and define how this position should be reached (linear/joint movement).

3. Repeat these steps and add digital output commands or program flow commands in between
if needed.

The integrated editor is provided for creating and editing these programs.

7.1 Program Editor

Each command of the robot program consists of one line, e.g. "Joint" or "Wait". Only commands that
control the program flow are divided into several lines, e.g. "Loop" and "EndLoop". The program
editor is opened with the "Edit" button in the "Motion" tab ofiRC.

Figure 12: The program editor is opened by clicking "Edit".

The following window opens, here with a short program:

Figure 13: Program editor with a shord programm

The following sections show how to create a program with the program editor.

7.1.1 Changing the Command Sequence

To move a command, use the arrows on the right side of the command line. Alternatively, you can
click "Down" or "Up" from the command context menu (see Fig. 14).
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Figure 14: The context menu of a command

The program editor prevents invalid commands that would break the structure of the program. If
moving a command up or down is not possible, the corresponding buttons and menu items are
grayed out.

7.1.2 Touching Up Positions

Certain commands require position values as parameters. It is often desirable to use the current
position of the robot. Entering it by hand can take some time and is prone to errors. For such cases
you can use the command "Touch Up":

• Select the command and click "Touch Up!" from the "Edit" menu.
• Select the command and then press Ctrl+T.
• Open the context menu by right-clicking on the command and click on "Touch Up!" (see Fig.

14).
The program editor then replaces the position values in the command with the current position of
the robot.

7.1.3 Set Start Command

It is possible to execute programs command by command or to select a specific command as the
starting point of a program for test purposes. The command that will be executed first the next time
the program is started, or - if the program is currently running - the currently executed command is
marked by a dot in the program editor. The subprogram containing this command is also marked by
a dot in front of the program name.
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Figure 15: The ribbon at the top of iRC shows the state of the robot and logic program

Figure 16: Using the variable #logicprogramrunning the robot program can check if the logic program
is running

To select a specific command as the starting point for execution, click on "Start Here" in the context
menu (see Fig. 14).

7.2 Robot and Logic Programs

Within a robot program, instructions are always executed one after the other. So it is not possible, for
example, to switch a digital output or perform calculations during a movement. If this is necessary a
logic program can be used.
A logic program is created like a robot program via the program editor, but must not contain any
movement instructions. After it is assigned, it is repeated permanently, even if the actual robot pro-
gram is not running. To load a program as a logic program, it needs to be transferred to the robot
controller first by loading it once like a normal program. After that it can be assigned in the configu-
ration area "File" → "Configure Project" → "Program" → "File logic".

ð
Programs have a minimum execution time of 500ms. Shorter programs, for example
fast running logic programs, may be delayed during the automatic restart. This is espe-
cially important if the logic program is used to switch digital outputs or to evaluate the
states of the inputs. If a fast repetition of the program is necessary a continuous loop
(condition "False") can be created which contains all other instructions of the program
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�
Example: To apply glue a valve is to be opened during movement.

1. Define the motion in the robot program.

2. Before the movement starts, set a global signal (GSig, instruction "Digital output")
in the robot program to signal the logic program that it should soon switch the
digital output for the valve.

3. Create a logic program with an infinite loop (loop with condition "False"). See
info box above.

4. In loop of the logic program, create a condition statement ("IF"), define its con-
dition so that the global signal must be active and the target position is reached.
For example "GSig1 and #position.x > 150" if the output should be activated from
X=150mm.

5. In the first branch of the condition command set the digital output to activate the
valve.

6. Also reset the global signal in the first branch so that the condition is not called
again in the next run. In more complex applications the logic program could also
set a second global signal to close the valve again after reaching the end target
position.

7.3 Comments and Information within the Program

7.3.1 Information about the Program

The program editor inserts the pseudo command Start at the beginning of each program. It does
not represent a real command, but displays information about the current hardware, software and
kinematics. It is not possible to move or remove it.
When loading a program, this information is compared to avoid executing an incompatible program.

Figure 17: The Start line contains information about the current hardware.

7.3.2 Descriptions

Each command of a program contains a description. It should be used to describe to other users what
the command is for.

7.3.3 Comments

The Comment command can be used to insert plain descriptions into programs. It has no effect to
the robot during execution.
It can be found in the program editor in the menu item "Special" → "Comment".
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7.4 Motion

7.4.1 Abort Conditions

Each motion command can be provided with a abort condition. It is a conditional expression that
follows the syntax described in section 7.6.1. During the execution of the motion command, the in-
struction is continuously evaluated, and the moment it evaluates to "true", the robot stops moving.
It can be specified respectively under "abort condition" for each motion command.

7.4.2 Acceleration and Smoothing

To prevent abrupt movements an axis acceleration (percentage of maximum acceleration) and a
smoothing factor can be specified for each motion command. With a smoothing factor of 1-100%,
the motion instruction is smoothed with the following instruction, so that, for example, several linear
movements form smooth curves instead of stopping at each target point and starting again.
Smoothing is only possible with immediately following motion commands of the same type. E.g.
linear and circular movements can be smoothed with each other and axis movements with them-
selves. If a motion sequence is interrupted by a motion of a different type or by a logic instruction, the
smoothing is also interrupted and the robot stops briefly. The maximum number of commands that
can be smoothed is limited to 5-20, depending on the robot, in order to prevent calculation pauses in
the program sequence. In case of long paths this is shows by regular braking and restarting.

�
If your application requires long uninterrupted paths you can increase the limit. Note
that this can lead to a short calculation pause before starting a very long paths. More
information can be found on our wiki under the keyword "LookAhead".

https://wiki.cpr-robots.com/index.php/Motion_Smo
othing

7.4.3 Joint Motion

The Joint command moves the robot to an (absolute) target position specified in axis coordinates.
The resulting movement of the TCP is usually a curve and not a straight line. The target position can
be specified in the following way (select the appropriate "source"):

• "Constant": The target position is a constant value for each axis.
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• "Variable": The target position is taken from the position variable specified in "Variable".

The movement speed is indicated by "speed". It is measured in percent of the maximum allowed
motion speed for the respective robot axes.
The joint command can be called in the program editor under the menu items "Action" → "AxisMo-
tion" and "Action" → "VariableMotion" → "AxisMotion".

7.4.4 Linear Motion

The Linear command moves the robot to an (absolute) target position specified in cartesian coordi-
nates. The resulting movement of the TCP follows a straight line. The target position can be specified
as follows (select the corresponding "source"):

• "Constant": The target position is a constant given by Cartesian coordinates x, y, z and Euler
angles A, B, C as well as the positions of the external axes if supported by the current robot
kinematics.
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• "Variable": The target position is taken from the position variable specified in "Variable".

The movement speed is specified by "Speed" in mm/s. If it exceeds the maximum allowed movement
speed of the robot, it will cause a kinematic error during execution. The Linear command can be
called in the program editor under "Action" → "Linear Motion" and "Action" → "Variable Motion" →
"Linear Motion".

7.4.5 Relative Motion

The Relative command allows to move the robot relative to its current position. It can be called from
the menu items under "Action" → "Relative Motion".
Under "Type" the following modes of relative movement can be selected:

• "Joint": The relative offset is specified in axis coordinates. The motion speed is specified by
"Speed" in percent of the maximum allowed motion speed for the respective robot axes.

• "Linear - Base": A linear motion is performed with an offset specified in Cartesian coordinates.
The coordinate system used for the offset is the robot coordinate system. The velocity is speci-
fied by "Velocity". It is measured in mm/s, if it exceeds the maximum allowed motion speed of
the robot, it will cause a kinematic error during execution.

• "Linear - Tool": A linear movement is performed with an offset specified in Cartesian coordi-
nates. The coordinate system used for the offset is tool coordinates. The speed of movement
is specified by "Speed". It is measured in mm/s. If it exceeds the maximum permissible move-
ment speed of the robot, this will result in a kinematic error during execution.
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7.4.6 Circular Motion

The instruction "Circular Motion" enables movements along a full or partial circular path. It is com-
patible with linear movements, so that the transition from and to linear movements can be smoothed.

The circular path is defined by three points and optionally a target angle. The starting point is the po-
sition before the start of the circular command, usually the target position of the previous instruction.
Position 1 is a helper position on the circular path. Position 2 is the target position on the circular path.
If a target angle is specified, the movement can stop before reaching the points or go beyond them.
If angles greater than 360° are specified, the circle is moved several times, negative angles reverse the
direction of the motion.

,
The circular motion should not be the first motion instruction in the robot program. If
the program starts at an unexpected position, the circle may become larger or smaller
than expected.

In addition, the target orientation of the tool and the target positions of the external axes can be
specified. These are linearly interpolated over the circular path.
The positions can be defined as constants via two position variables. In this case, the target orienta-
tion and the external axes must be specified in the variable for position 2 (target position).
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�
Programming a curve path by Teach-In

1. Move the robot to the start position of the curve and add a linear instruction.

2. Move the robot to any position on the curve, e.g. half way. Add the circle instruc-
tion.

3. Move the robot to the end of the curve and click the "Set current position" button
in the "Position 2" line.

4. Optional: click the "Set Current Ori + Ext" button if the tool orientation or external
axes change during the curve path.

�
Programming a circular motion by calculating the circle points
For simple circular motions aligned with the axes of the coordinate system, it is rec-
ommended to calculate the coordinates of the center of the circle to calculate the start,
auxiliary and target positions and add or subtract the radius along the Cartesian axes.

7.4.7 Set Velocity

The instruction "Set Velocity" instructs an external axis to move at a constant velocity, for example for
a conveyor belt. The movement stops only when a movement of 0 units/s is assigned or the program
is stopped. This function only affects external axes configured for velocity mode.

7.5 Gripper and Digital In-/Outputs

7.5.1 Digital Inputs

The states of the digital inputs can be used in conditions (see section 7.6.1). The first digital input of
the first digital I/O module has the number 21 and can be used in conditions via the keyword DIn21.

7.5.2 Digital Outputs

The Digital Output command is used to set digital outputs and global signals.
Under "Channel Type" it is specified whether a digital output or a global signal is to be set. Under
"Channel ID" the channel of the digital output or the global signal is specified, under "State" the
desired state after execution of the command is specified. The command is accessible in the program
editor under "Action" → "Digital output".

7.5.3 Global Signals

Global signals are internal flags that can be set in the robot program like digital outputs and evaluated
like digital inputs. They can be used for example to store simple state information or to communicate
between robot program and logic program. Since global signals can also be read and set via the CRI
and Modbus interfaces, robot programs can also use them to communicate with external applications
or a PLC. The concept of global signals is similar to coils in Modbus or a boolean in high-level language
programming.
In conditions in the robot program, the GSig keyword can be used to query the state of the global
signal. For example GSig1 for the first signal. There are 100 global signals available.
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7.5.4 Opening/Closing the Gripper

The Gripper command allows controlling the robot’s gripper. It is accessible in the program editor
through the menu item "Action" → "Gripper".
Under "Opening" you can set the desired opening, measured in percent. A value of 0% stands for a
completely closed gripper, 100% for a completely opened gripper. For grippers that can only be either
fully opened or fully closed, the threshold between these states is 50%.

7.6 Program Flow

7.6.1 Conditions

Conditions can be used in if-then-else instructions, loops, and as termination conditions in motion
instructions. The conditions can be combinations of digital inputs, global signals, boolean operations
and comparisons. Capitalization and spaces between symbols are ignored.
In the simplest case, for example, a condition can check whether a signal is present at digital input
21:

DIn21

More complex conditions can be constructed using the AND and OR keywords and parentheses. The
following condition is met if a signal is present at either input 21 or inputs 22 and 23:

DIn21 OR ( DIn22 AND DIn23 ) .

To negate an expression put an exclamation mark (!) in front of it. This is also possible before paren-
thesized expressions. The following condition is met if either there is no signal at input 21 or if there
is no signal at inputs 22 and 23 together:

! DIn21 OR ! ( DIn22 AND DIn23 )

Likewise, the state of global signals (see section 7.5.3) can be queried. Global signals are internal flags
which can also be used for communication between robot and logic program and external applica-
tions or PLC:

GSig1 AND ! DIn21

�
The states of the digital outputs cannot be queried in conditions. If necessary, a global
signal representing the output can be set after setting the output.

In addition, the values of number and position variables can also be checked. Number variables
represent a single number while position variables contain several number components. For position
variables, it is therefore always necessary to specify which component is to be compared.

mynumbervariable = 5
mynumbervariable < 10
mypositionvariable >= 42
mypositionvariable . X = 123
mypositionsvariable . B >= 90
mypositionvariable . A3 > 300
mypositionvariable . E1 < 500

Numeric values can also be compared to each other:

mypositionvariable . X > mynumbervariable
mypositionvariable . A1 <= otherposit ionvariable . A1
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The following position components can be used to compare positions:
• cartesian

– X, Y, Z - position in millimeters
– A, B, C - orientation in degrees

• axis positions
– A1 to A6 - robot axes in degrees or millimeters
– E1 to E3 - additional axes in degrees, millimeters or self-defined unit

In summary, the condition syntax can be described by the following EBNF definition:

Expression : = ["!"] <Boolean> <BooleanOperator> <Boolean> ...

Boolean : = <BooleanConstant> | <Expression> | "(" <Expression> ")" | Com-
pExpression | "(" <CompExpression> ")" | <DigitalInputs> | "(" <Dig-
italInputs> ")"

BooleanOperator : = "And" | "Or"

BooleanConstant : = "True" | "False"

Digital Inputs : = <ChannelType> <ChannelId>

ChannelType : = "Din" | "GSig"

Channelld : = Integer value

CompExpression : = <CompValue> <CompOperator> <CompValue>

CompValue : = <Variable> | <Number>

Variable : = <Numbervariable> | < PositionComponent>

Numbervariable : = Name of a number variable

Positions component : = <Position variable> "." <Component>

PositionVariable : = Name of a position variable

Component : = "x" | "y" | "z" | "A" | "B" | "C" | "A1" | "A2" | "A3" | "A4" | "A5" | "A6" |
"E1" | "E2" | "E3"

Number : = Integer or floating point number

CompOperator : = "=" | ">" | "<" | ">=" | "<="

7.6.2 Stop

The command "Stop" stopps the program execution.
It is available through the menu item "Flow" → "Stop".

7.6.3 Pause

The Pause command pauses the execution of the program. The execution can be resumed later by
the user.

7.6.4 Wait

The Wait command instructs the robot to wait until a specified amount of time has passed or a condi-
tion is met. It is accessible via the menu items under "Program Flow" → "Wait" in the program editor
of the iRC.
The different modes can be selected under "Type":
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• "Timeout": The time specified in "Timeout" will be waited.
• "Condition": Waits until the condition specified in "Expression" evaluates to "true".

7.6.5 If-then-else

The If command branches the execution of the program depending on the value of a conditional
expression. It is accessible through the "Flow" → "If...then...else" menu item in the iRC program
editor.
The specified condition must conform to the syntax described in section 7.6.1. The statements be-
tween "If" and "Else" will be executed if the condition evaluates to true. Otherwise the statements
between "Else" and "EndIf" will be executed.

Figure 18: The If statement branches the program flow.

7.6.6 Loops

The Loop command allows the definition of execution loops. Under "Type" you can choose between
the following loop types:

• "condition": The loop is repeated until the specified condition evaluates to "true". It must
conform to the syntax described in section 7.6.1.

• "counter": The loop will repeat the number of times specified in "repeats".
The loop command is accessible through the menu items "Flow" → "Loop".

7.6.7 Matrices / Palettizing

The matrix instructions calculate positions aligned to a grid, e.g. as gripping or depositing position
for palletizing tasks. Figure 19 shows a motion pattern that can be executed by using the raster in-
structions.
iRC provides two approaches to program this:

Statement type Description

Matrix loop Executes a statement block for each raster position.

Matrix definition and raster query Allows to calculate arbitrary raster positions based on an in-
dex variable.

The matrix loop is suitable for simple use cases where the positions are processed strictly in their
order. The loop starts with the first position and is left after the last position. The matrix definition and
query is more flexible, several grids can be used at the same time and the positions can be retrieved
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Figure 19: The matrix movement is from point A to B, then offset in direction C
.

in any order, but the index variable must be counted by additional logic. This allows e.g. to start with
a partially filled palette or to skip positions.
The matrix loop can be added via the menu item "Program flow" → "Loop" → "Raster". Matrix defi-
nition and matrix query are located in the menu "Special commands" → "Raster".
The position variables specified as "Point A", "Point B" and "Point C" define the corners of the area
covered by the raster loop (see figure 19). The number of steps to be taken is specified by "counter X"
(from A to B) and "counter Y" (from A to C). For example, in the figure above, X=4 and Y=3.

Figure 20: Definition of a matrix loop

The block between "Matrix" and "Matrix End" is executed for each step. The position variable "Tar-
getPosition" contains the position of the current target point for the respective step. Row and column
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of the current step are stored in the number variables given to "Counter X" and "Counter Y" respec-
tively.
The matrix definition and query instructions use the same parameters: The dimensions and positions
are specified in the raster definition, and the index and output variables are specified in the raster
query. Different rasters are identified by a name.

Figure 21: Usage of matrix definition and matrix query commands. The definition of variables is
omitted.

7.6.8 Subprograms

Subprograms can be executed using the Sub command.
The path to the subroutine file is specified under "Filename". It is relative to the subfolder "Pro-
grams" of the iRC folder "Data". The command can be invoked from the menu item "Programflow"
→ "Subprogram".

7.7 Variables and Variable Access

Programs for iRC and TinyCtrl support two types of variables:
• Number variables: These can be used to store integer or floating point numbers.
• position variables: These can be used to store cartesian and joint positions. Whether such a

variable is interpreted as cartesian or joint depends on the context.
The cartesian components x, y, z are in mm, the euler angles A, B, C are in degrees. The joint
values are measured in mm or degrees depending on the type of axis.

7.7.1 User-defined Variables

It is possible to define variables with the Store command, which is accessible in the program editor
through the menu items under "Special" → "Variable definition".
Three types of store operations can be selected:

• "Current position":
A position variable is initialized with the cartesian and axis position of the robot when the com-
mand is executed.

• "NumberConstant":
A number variable is initialized with the constant specified in "value" (see 22).

• "PositionConstant":
A position variable is initialized with the constants specified in "Cartesian Position", "Joint Po-
sition" and "External Joints" (see fig. 23). Depending on the kinematic model of the current
robot, certain axes may not be available.

The name of the variable can be set under "Variable". If a variable with the same name is already
defined, its value and type will be overwritten. All variables are global, i.e. they are also accessible
from subroutines.
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Figure 22: Definition of a number variable.

Figure 23: Definition of a position variable.
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7.7.2 System Variables

The following predefined variables are available without having to define them:
• #position: The current position of the robot.
• #programrunning: 1 if the robot program is running, otherwise 0.
• #logicprogramrunning: 1 if the logic program is running, 0 otherwise.

Note that the system controls the values of predefined variables - they cannot be changed by the
program. The names of predefined variables always start with "#"

7.7.3 Accessing Elements

Position variables contain the following elements:
• Position: x, y, z
• Orientation: a, b, c
• Joint positions: a1, a2, a3, a4, a5, a6, e1, e2, e3

The elements are accessed by appending them with a dot, e.g. "myvariable.x" or "myvariable.a3".

7.7.4 Calculating with Variables

Calculations with variables can be performed using the Math command, which is accessible in the
program editor via the menu item "Special" → "Variable operation".
"First operand" defines the first operand of the operation to be executed. It is also used to store the
result.
"Second operand" defines the second operand of the operation. It can contain numeric constants,
names of number variables or components of position variables.
The following operations are supported and can be selected under "Operation":

• Assignment: The first operand is set to the value of the second operand.
• addition: The first operand increased by the value of the second operand.
• subtraction: The first operand is decreased by the value of the second operand.
• Multiplication: The first operand multiplied by the value of the second operand.
• Division: The first operand divided by the value of the second operand.
• Modulus: The remainder of the division of the first operand by the second operand is stored in

the first operand.
The following combinations of operands and operators are allowed (number here also means position
components):

Assignment Plus Minus Multiplication Division Modulus

Both are number x x x x x x

Both are position x x x

Op 1 is position, Op 2 is num-
ber

x x x

Op 1 is Number, Op 2 is posi-
tion

7.7.5 Observing Variables

You can observe the current values of all defined variables in iRC in the "Programs and Variables" tab
in the status area.
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Figure 24: The values of the variables are displayed in the info area.

7.8 Camera

The camera instruction allows object information to be retrieved from an object detection camera.
The information includes grab position and orientation, as well as object type and detection state.
To use a camera, it must be defined and calibrated in the configuration area (see section 9.2.5). The
program instruction can be added via the menu item "Special Commands" → "Camera".

Figure 25: Camera command in the program editor.

Under Type the type of camera must be selected, under Name the name defined in the configuration
must be entered. The output variables for target position and model class must have been declared
beforehand by store command. The target position contains the position and orientation of the object
in the coordinate system of the robot, while the model class contains an identification number for the
detected object type. If no object was detected the value of the model class is "-1".

ð
The camera command does not wait if no object has been detected. Use an If statement
or a condition loop to check whether the camera has actually detected an object!
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ð
The orientation of the object can cause a slow linear movement of the robot!
If the rotation of the tool axis takes longer than the movement of the tool to the object
position, then the movement is slowed down accordingly. This happens even if no tool
axis is installed. If the object orientation is not relevant or no tool axis is installed, this
can be avoided as follows:

1. Determine the orientation of the robot before moving to the object position, for
example by defining a new position variable there and initializing it with the cur-
rent position. If no tool axis is installed you can use the constant orientation val-
ues from the information area of iRC.

2. Create three assignment statements (Math statement) and overwrite the A, B and
C components of the target position with the determined values.
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8 Hardware Configuration

In order to use additional hardware such as switches, PLCs, actuators, axis brakes or additional axes,
these must first be connected and configured. This chapter explains how to configure the hardware
related to axes and input/output. Further settings concerning the behavior of the robot and the soft-
ware interfaces (including cameras) can be found in chapter 9.

8.1 In-/Outputs

The ReBeL has digital inputs and outputs in the base and on the arm behind joint A4:
• Base: 7 digital inputs and outputs each. They are addressed by the names DIn21 to DIn28 or

DOut21 to DOut28.
• Arm: 2 digital inputs and outputs each. They are addressed via the names DIn31 and DIn32 or

DOut31 and DOut32.
• Global signals: These are virtual inputs/outputs. They can be set and read via robot programs,

the CRI interface or the Modbus interface. Up to 100 global signals can be used.
The status of the DIO is visible via the DIN rail inputs/outputs tab, where the outputs can also be
switched manually. The inputs and outputs can be configured in the project configuration area under
"Inputs/Outputs".

8.1.1 Electrical Integration

The easiest way to connect switches, actuators or PLCs is via digital inputs and outputs. The ReBeL
has two integrated DIO modules; 8 inputs and outputs are available at the base, 2 inputs and outputs
each are available at the arm for tools. The socket on the arm is supplied with 6 or 8 poles, check
which variant is installed on your robot.
The inputs and outputs are not galvanically isolated from the robot controller, the voltage is provided
by the robot’s power supply. A maximum of 500mA may flow through all inputs and outputs. Devices
that require a different voltage or higher currents or where there is a risk of larger voltage or current
fluctuations should be connected via relays, for example.

Figure 26: Switches, sockets and their pins at the base of the robot
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Socket Name Plug

X1 Power supply Molex 39012065

X2 Emergency stop M8 4-pin female

X3 Soft on/off button with status light

X4 Digital inputs PhoenixContact 1844633

X5 Ethernet, default IP 192.168.3.11

X6 - X9 USB sockets, not used

Table 7: Names of the sockets and switches on the base (see fig. 26)

The status light at X3 can show the following states:
• Green: no error, axes enabled.
• Red: error or axes not enabled. The error code is displayed in iRC.
• Orange: integrated robot controller not yet connected (startup), please wait.

Socket Pin Description

X1 1-3 Power supply 24V

4-6 Power supply GND

X2 1 Emergency stop CH1-Out (24V)

2 Emergency stop CH1-In

3 Emergency stop CH2-Out (24V)

4 Emergency stop CH2-In

X4 1 24V for digital inputs

2-8 Digital inputs DIn21 - DIn28

9 GND for digital outputs

10 - 16 Digital outputs DOut22 - DOut28

Table 8: Pin assignment of the sockets on the base (see fig. 26)

Figure 27: 8 pin DIO socket at the robot arm

Figure 28: Pins of the 8 pin DIO socket at
the arm
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Pin Description Cable color

1 n.cv. white

2 n.c. brown

3 DIn32 green

4 DIn31 yellow

5 +24VDC (max 500mA) gray

6 DOut32 pink

7 DOut31 blue

8 GND red

Table 9: Assignment of the 8 pin DIO socket at the arm (see fig. 28)

Figure 29: 6 pin DIO socket at the robot arm

Figure 30: Pins of the 6 pin DIO socket at
the arm

Pin Description Cable color (according to binder-Kabel)

1 +24VDC (max 500mA) brown

2 DIn32 white

3 GND blue

4 DIn31 black

5 DOut32 gray

6 DOut31 pink

Table 10: Assignment of the 6 pin DIO socket at the arm (see fig. 30)

8.1.2 Software Configuration

The software and integrated control are preconfigured for the two DIO modules of the ReBeL.
You can enter a descriptive name for each input and output. This is only relevant for the display, but
not as a name in program conditions. The reset state indicates which state an output changes to on
reset, the error state is assumed if an error occurs.
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8.1.3 Connect sensors and buttons to the base

• The input signal (positive +24V) must be connected to an input pin X4 pins 2-8. X4 pin1 can be
used as power supply e.g. for switches.

• The status of the inputs can be monitored in the register "Input/Output" below in iRC.
• A robot program can request inputs and react to them, e.g. with an if-then-else instruction

8.1.4 connect actuators to base

• The actuator (relay etc.) is supplied with +24V via a free DOut pins 10-16 if the DOut is set to
true. X4 pin 9 can be used as GND.

• You can set the outputs manually in the register "Input / Output" below in iRC.
• A robot program can set the state of the outputs with the digital-out instruction.

8.1.5 connect sensors and buttons to the arm

• The sensor signal (positive +24V) must be connected to an input pin pin 2 or pin 4. Pin1 can be
used as power supply e.g. for switches.

• The status of the inputs can be monitored in the register "Input/Output" below in iRC.
• A robot program can request inputs and react to them, e.g. with an if-then-else instruction

8.1.6 connect actuators to arm

• The actuator (relay etc.) is then supplied with +24V via a free DOut pin 5 or pin 6 provided the
DOut is set to true. Pin 3 can be used as GND.

• You can set the outputs manually in the register "Input / Output" below in iRC.
• A robot program can set the state of the outputs with the digital-out instruction.

Translated with www.DeepL.com/Translator (free version)

8.2 Motor Brake

Electromagnetic brakes are installed in the ReBeL to prevent the axles from sagging. By applying a
voltage, the axles are released. Without voltage, they fall into the braking state by springs.
The brakes of the ReBeL are controlled by the motor electronics, therefore no additional configuration
is necessary. The settings in the configuration area of iRC have no influence.

8.3 Motor control configuration

For the fine adjustment of the movement and the referencing, each axis module contains its own
configuration set. This can be retrieved and modified via the buttons "File" → "Download firmware
parameters" or "Upload firmware parameters". After downloading, the configuration set is created in
the installation directory of iRC under Data\Backup.
A detailed description of the parameters can be found at the following link:

https://wiki.cpr-robots.com/index.php/Firmware_P
arameter_Configuration

,
Change the firmware parameters only if you know what you are doing. Test the robot at
slow speed and observe the temperatures of the electronic modules and motors.
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9 Software Configuration

The behavior of the robot can be changed via the configuration. The most important parameters can
be found in the configuration area of iRC - igus Robot Control, which can be opened via "File" (see
Fig. 31). Settings concerning the project can be found under "Project configuration", cross-project
settings under "Robot configuration". The interfaces can also be configured on a project-by-project
basis via "interface configuration".

Figure 31: The project configuration area.

More specific settings can be made via the project, robot, and tool configuration files. The settings of
the axis modules can be accessed and changed via "Get/Set Amp Configuration" (see section 8.3).

,
Change the configuration files only if you know what you are doing! Test the robot care-
fully, because it could move unexpectedly fast or collide! Changes of the firmware pa-
rameters can lead to overheating of the motors or the electronics!

If you use a robot with integrated controller (TinyCtrl), the changes must also be made there. When
making changes via the configuration area, connect the robot first. Clicking on "Apply" or "Save
Project" will automatically synchronize the changes with the robot controller. Changes to the config-
uration files must be transferred manually, use the "Access Configuration" area.

ð
Some changes to the integrated robot controller are only applied after a restart. Wait at
least 20 seconds after the transfer and restart the robot.
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9.1 Project Configuration

9.1.1 Program

Here you can set the robot and logic program, the movement speed (as a percentage of the maximum
speed), the replay mode and the reaction to program errors.

9.1.2 Tool

The mounted tool can be defined here. Changing the tool requires reloading the project or restarting
the integrated control.
New tools can be defined as configuration file in the directory "Data/Tools". New and changed tools
are not automatically synchronized with the integrated control. To commit changes, open the "File"
→ "Tool Configuration" area, click the "Add" button in the "Tool Configuration" area and select the
new tool configuration file.

9.1.3 Inputs/Outputs

Here the number of input/output modules and the behavior of the inputs/outputs can be set. The ba-
sic inputs/outputs are only relevant for robots of the Mover series, all other robots are configured via
the "DIN-Rail inputs/outputs" area. The global signals are internal flags for communication between
robot programs and PLC.
For each digital output can be specified which state is assumed at reset and in case of error.

9.1.4 Virtual Box

The virtual box defines an area that the tool center of the robot must not leave. If the limits are ex-
ceeded, the movement stops.
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9.2 Interfaces

For communication with and control by other software and devices iRC offers a PLC interface, the
CRI Ethernet interface and an interface for connecting ifm O2D cameras.

9.2.1 PLC Interface

The PLC interface enables the execution of basic functions and the signaling of states by means of
digital inputs and outputs. In addition to control by a PLC, this interface also enables operation by
hardware pushbuttons.
The PLC interface requires unused digital inputs and outputs. It reacts to rising edges at inputs.
The following input functions are supported:

Parameter Meaning

Enable Executes Reset and Enable

Request reference Starts the referencing of all axes

Play Starts the execution of the loaded program if no program is running, con-
tinues a paused program or stops the execution of a running program

Pause Pauses a running program or continues a paused program

Alt Start One-button control: Executes the following functions in succession when
the button is pressed several times: Reset, Activate, Reference (if not yet
done), Start program

Alt Stop One-button control: Executes the following functions in succession when
the button is pressed several times: Pause, Stop, Reset

Shutdown Shuts down the control computer

Start Platform Mission Starts the mission of the mobile platform

Add joint command Add-Axis statement to the current position in the program editor

Add linear command Add-Linear statement to the current position in the program editor

ð
Add-Joint and Add-Linear can only be used if iRC is connected to the robot.

The following output functions are supported:

Parameter Meaning

No fault Output is active when the robot is in fault-free state

Fault Output is active when the robot is in fault state

Robot is referenced Output is active when all axes are referenced

Program running Output is active when a program is running

No program running Output is active when no program is running

Platform mission running The mobile platform is executing a mission

The configuration of the PLC interface is done via the configuration area in iRC (File → Configure
Interfaces → PLC interface). To configure a robot with integrated control it must be connected. The
field "Active" activates the interface, "Automatically connect" causes iRC to try to connect to the robot
automatically. The number fields to the inputs and outputs correspond to the numbers of the digital
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inputs/outputs. To disable individual functions, select a number that is not present on any hardware
module, e.g. "1".

9.2.2 Program Selection via Digital Inputs

Robot programs can be loaded and started via digital inputs or global signals. This is useful, for exam-
ple, if a program is to be selected from a given selection via pushbuttons or the CRI-GSig instruction.
The configuration for this can be found in the configuration area of the PLC interface in the section
"Program Trigger".
The following parameters can be specified for each program trigger:

Parameter Meaning

Active Enables the program trigger

Type Type of input signal: digital input (DIn) or global signal (GSig)

Number Number of the input. E.g. 21 for DIn21 or GSig21

Program Type Robot program or platform mission

Program File Program or mission file. Must be in the programs or missions directory

9.2.3 Modbus

With the Modbus TCP interface, for example, PLCs can send data and instructions to the robot con-
troller and receive status information. For more information on the use and licensing of this interface,
see section 10.
The Modbus interface can be enabled through the interface configuration. Unlike the other configu-
ration parameters, these settings are not mirrored with the connected system to prevent the configu-
ration of the integrated controller and the control software on the Windows PC from colliding. For this
reason, if a robot controller is connected, the parameters displayed refer to it; if none is connected,
they refer to the PC software.
The following parameters can be configured:

Parameter Meaning

Enabled activates the Modbus server

Port TCP port of the Modbus server

Max connections Maximum number of simultaneous connections to the server (inte-
grated control only)

9.2.4 CRI Interface

The CRI interface allows you to send complex instructions and retrieve information and settings via
the Ethernet interface using TCP/IP. iRC uses this interface to connect to robots with integrated con-
trol or other instances of iRC. By default, this interface is disabled in iRC.
Documentation of all supported instructions as well as sample code can be found at the following
link:

https://wiki.cpr-robots.com/index.php/CRI_Ethernet_Interface

To enable the interface in iRC open the configuration area (File → Configure Interfaces → CRI inter-
face). The "Start" button starts the CRI server, "Stop" stops it. The status field shows the bound IP
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address and port, and the number of connected clients. If a specific IP address is to be used, it can be
entered in the field below.

9.2.5 Camera Interface

The camera interface enables the use of object recognition and video cameras. Object recognition
cameras detect the position and class of objects and transmit this data to the robot controller; image
data is optional. If the camera provides positions as pixel coordinates, the robot controller calculates
the corresponding positions in the robot coordinate system. Video cameras only provide images and
can therefore only be used to observe the work area, but not for object recognition.
Currently, the robot controller supports the following camera types:

• ifm object detection cameras of the O2D200 and O2D500 series and cameras that can emulate
their TCP/IP protocol.

• USB video cameras (e.g. webcams and industrial cameras supporting USB video class (UVC))
The cameras can be added to the robot controller via the "Cameras" section of the interface configu-
ration. There, a distinction is made between cameras on the PC and the integrated controller. If the
robot is controlled by an integrated controller, then the cameras must be configured there.
The following sections describe the configuration of both camera types.

�
Not every integrated controller supports USB video cameras. The USB camera section
below explains compatibility.

Camera Interface for Object Recognition

For object recognition only the ifm O2D200 and O2D500 cameras are currently supported as well as
cameras that can emulate their TCP/IP protocol (as described here: https://wiki.cpr-robots.co
m/index.php/Remote_Variable_Access#Protocol).

�
For step-by-step instructions and tips on parameterization, please refer to our Wiki ar-
ticle:

https://wiki.cpr-robots.com/index.php/2D_Camer
a_Integration

To enable the camera to communicate with the robot controller, first set the following parameters via
the camera manufacturer’s software:

• ifm O2D200
– Format: ASCII
– protocol version: V2 or V3
– object detail output: on
– start string: start or star
– stop string: stop
– Separator character: #
– image output: any
– image format: Windows Bitmap

• ifm O2D500
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– Protocol version: V3
– For "contour presence control" mode:

* Model result: on

* ROI results: on

* object results: any

* start: start or star

* separator: #

* end: stop

* number of objects: 1
– For custom mode:

* Use the provided protocol preset
To use a camera it must be configured in the configuration area (File → Configure Interfaces → Cam-
eras). If the camera is to be configured on a robot with integrated controller, iRC must be connected
to it.
Select the type of camera ("IFM O2D") and click "Add Camera" to add a camera. The "General" area
contains the following parameters:

Parameter Meaning

Image enabled If this field is activated, the robot controller regularly requests the current
camera image if the camera does not send it automatically. Supported are
images in the format "Windows Bitmap" (O2D200) and "JPEG" (O2D500).

Image enabled If this field is activated, the robot controller regularly requests the current
camera image if the camera does not send it automatically. Supported are
images in the format "Windows Bitmap".

Name Name of the camera in the robot program

Description Optional description

IP address IP address of the camera

Port Port number of the camera

The entries in the "Coordinate transformation" area determine the processing of the position data
supplied by the camera. Depending on the camera settings, these are transferred as image coor-
dinates (pixel position) or robot coordinates (in mm). Image coordinates must be transformed into
robot coordinates by the robot controller; the values in the "Geometry" area are used for this purpose.
See figure 32.

Parameter Meaning

Scaling Scales the pixel position

Origin Position of the camera in the robot coordinate system

Look Viewing direction of the camera. A downward pointing camera has Z=-1

Up X Direction of the camera in the robot coordinate system

Z Distance Distance of the objects from the camera

The simulation section enables the simulation of the camera. This function is not available in the
integrated control.
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Figure 32: Measuring the camera position and orientation.

Parameter Meaning

X, Y, Z Object position XY in pixels (0-640 or 0-480) or XYZ in mm, depending
on the setting "Source coordinate type"

Orientation Rotation in degrees

Model class Class of detected object, the value -1 means no object is recognized

After configuration, the detected and
calculated values can be observed in the
status area. Images received from the
camera are displayed here.

Figure 33: Camera status area

�
Note that O2D500 type cameras in "Contour Presence Control" mode do not provide
model IDs after completing the setup wizard. With only one object type this should not
be a problem, but if you want to distinguish objects an alternative protocol preset with
model IDs can be selected. See the link in the previous note for more info

.
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�
After making changes to the configuration of the camera via the manufacturer’s soft-
ware (e.g. changes to the model definition), click "Apply" once in the camera configu-
ration area of iRC. This will reconnect the camera. Otherwise, the camera may continue
to operate with the old configuration until it is rebooted

.

Camera Interface for USB Video

USB video class (UVC) cameras can be used to observe the work area, for example webcams or in-
dustrial USB video cameras. The robot controller forwards the received images via the following in-
terfaces:

• CRI interface: The image is transmitted via the Ethernet interface to iRC and can be observed
there in the camera status area (see fig. 33).

• Cloud interface: When this is enabled and the camera is assigned the image is transmitted to
the RobotDimension cloud. The image can be monitored via the website (see section 9.2.7).

�
Compatibility:
The USB camera interface is only supported by integrated controllers based on the
Raspberry Pi. Older robot controllers controlled by a Phytec module do not support
USB cameras. The Windows software iRC does not support this camera interface ei-
ther, here USB cameras can be assigned directly in the cloud configuration area (see
section 9.2.7).

Connect the camera to one of the USB ports on the control module. In the camera configuration area
of iRC, add a USB type camera, give it a unique name and select the device number. You may need to
try different numbers in the range 0-10. The camera status area displays the connection status and,
if successful, the camera image. To transfer the image to the cloud, the camera must be configured
using the specified name in the cloud configuration area.

�
The camera number may change after restarting the controller or if another camera
has been connected. Restart the controller after configuration and correct the number
if necessary.

9.2.6 Network

The WiFi interface of the integrated controller can be activated and configured via the network config-
uration area. When the configuration area is opened, it is automatically checked whether the function
is supported. Phytec-based robot controllers generally do not support WiFi, newer controllers may
require a software update.
To change the configuration, the "Change" box must first be set. Then the mode can be selected:
"Disabled" disables the WiFi interface, "Access Point" opens a new WiFi network, "Infrastructure"
lets the controller connect to an existing network. For an internet connection the latter is needed.
Then specify the parameters (depending on the mode, only the required ones are displayed):

Parameter Meaning

SSID WiFi network name

Password WiFi password

IP address WiFi IP address of the controller. You can use this to connect to the robot. Is
optional in infrastructure mode, in which case it is assigned automatically.
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Parameter Meaning

Router IP address The IP address of the router in infrastructure mode, which provides the
route to the Internet. This entry is optional, if empty it is assigned auto-
matically.

The settings are usually applied immediately. Only when activating and deactivating the interface is it
necessary to restart the controller. When the interface is activated, it may be blocked after the restart
(similar to the airplane mode of mobile devices), in which case the configuration area shows a button
that will enable the interface.

9.2.7 Cloud

The cloud interface enables remote monitoring of the robot via RobotDimension. After activation
and login, the robot sends basic status information and camera images to the online service, from
whose website they can be retrieved. Controlling the robot via the Internet is not possible.

https://www.robotdimension.com

To use the cloud interface, a controller with Internet connection is required, for example an integrated
controller as described in section 9.2.6 or a PC with iRC, which is connected to a robot. In addition, an
account with RobotDimension is required, there a separate robot password must be set in addition
to the online password.
The cloud interface can be activated via the interface configuration in iRC. To enter the user informa-
tion, the field "Set Credentials" must be set.

Parameter Meaning

User name login email address at RobotDimension

Password Robot password at RobotDimension

Client ID To distinguish multiple robots, if empty it will be randomly generated

The following data can optionally be sent to the cloud, it is for information only:

Parameter Meaning

Robot name Identifying name of the robot

Robot owner Owner or person in charge of the robot

The images from up to two cameras can be sent to the cloud, for example to monitor the work area
and the environment. For a robot connected to the cloud via iRC, USB cameras connected to the
PC can be selected via the device number. If successful, a preview image is displayed. In the case
of a robot with an integrated controller that connects to the cloud independently, USB and object
detection cameras can be configured in the camera configuration area and assigned here for image
transmission based on the name specified there.
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9.2.8 Secure Shell Access

The control computer can be accessed e.g. for maintenance purposes via secure shell (ssh) (port 22),
e.g. to change project files or robot files manually. Username is "robot", password is "robot".

Illustrated instructions are available here:

https://wiki.cpr-robots.com/index.php/FTP_and_p
utty_Access

,
The Windows software iRC and the Embedded control software TinyCtrl use configu-
ration files. If changes are made manually (e.g. in a text editor) to the configuration
files on one of these systems, they must also be made on the other side. Otherwise the
controllers do not behave identically, collisions may occur!

Via the software Putty one can connect to the Linux board and work on a command line. This way
you can for example view the live outputs of the robot controller.
For the work on the command line Linux knowledge is necessary!

1. Download and run Putty.exe.

https://putty.org

2. Establish the Ethernet connection. Connect LAN cable to Windows PC and integrated com-
puter. The Windows network adapter must have IP address 192.168.3.1, subnet 255.255.255.0.
The integrated computer has IP 192.168.3.11 in subnet 255.255.255.0.

3. Start Putty and in the field "Host Name (or IP address)" enter the address of the integrated
computer: 192.168.3.11. Set "Port" to 22 and "Connection Type" to SSH. Then click on "Open".
A window will open. You may be asked if this computer can be trusted.

4. Login: robot

5. Password: robot

6. After login you are in the home directory of the "robot" user, which contains the TinyCtrl direc-
tory, whose content is similar to the iRC directory in Windows.

7. Robot files are located in ~/TinyCtrl/Data/Robots/<robot type>/<robot model>/<robot model>.xml.

8. The project file where the robot file is referenced are located in ~/TinyCtrl/Data/Projects/Em-
beddedCtrl.prj

9. As editor nano, vim and vi are preinstalled.

10. After editing and saving the file, the controller must be restarted for changes to take effect.
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11. To display the TinyCtrl log output live in the terminal (this is especially useful after changes in
the files), TinyCtrl must first be terminated: killall TinyCtrl

12. Then navigate to the directory ~/TinyCtrl and start ./TinyCtrl

13. The process can be terminated by pressing Ctrl+C.

14. After restarting the controller TinyCtrl starts automatically.

9.2.9 SFTP Access

The "Secure Shell File Transfer Protocol" (SFTP) access works in principle like the SSH access in the
section above, but allows the user to make changes to the project and robot files for maintenance
purposes without having to use a terminal.

Illustrated instructions are available here:

https://wiki.cpr-robots.com/index.php/FTP_and_p
utty_Access

,
The Windows software iRC and the embedded control software TinyCtrl use configu-
ration files. If changes are made manually (e.g. in a text editor) to the configuration
files on one of these systems, they must also be made on the other side. Otherwise the
controllers do not behave identically, collisions may occur!

SFTP is the SSH File Transfer Protocol. It can be used to transfer or adjust files from one computer to
another. FileZilla is a free FTP program.

1. Download and install FileZilla Client:

https://filezilla-project.org

2. Establish Ethernet connection. Connect LAN cable to Windows PC and integrated computer.
The Windows network adapter must have IP address 192.168.3.1, subnet 255.255.255.0. The
integrated computer has IP 192.168.3.11 in subnet 255.255.255.0.

3. Start FileZilla and specify the following:

• Host: 192.168.3.11
• Username: robot
• Password: robot
• Port: 22

Then click Quickconnect.

4. The SFTP connection to the robot is now established:

• in the left window the local directory structure of the Windows PC is shown.
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• The right window of FileZilla shows the directory structure on the Linux computer.
• The embedded equivalent of the iRC control software is called TinyCtrl. It is located in the

~/TinyCtrl folder.
• The directory structure inside the TinyCtrl folder strongly resembles that of iRC.

Adjusting parameters in a robot or project file

1. To do this, navigate to the appropriate folder and copy the file to a local folder using "Drag and
Drop".

2. Here you can edit the file with a standard text editor like Windows Notepad. (Notepad++ is a
better text editor https://notepad-plus-plus.org/).

3. Once all changes are saved in the local file, it can be copied to the destination folder on the
Linux PC by "drag and drop".

4. This will overwrite the file in the destination folder "Overwrite"

5. To let the configuration change take effect, the controller must be restarted.

9.2.10 Uninterruptible power supply (UPS)

Under certain conditions it may be desirable to connect a low voltage supply. The "apcupsd" daemon
is integrated on the integrated control computer, which allows the controller to shut down safely in
the event of a power failure and possibly a subsequent low battery level. A "APC Back-UPS Pro 1500"
is supported. The UPS is connected to the control computer via USB cable. The robot controller is
connected to the UPS via Schuko plug. The UPS is connected to the mains. No further configuration
is necessary, because the "apcupsd" is preconfigured. If it is necessary to change the configuration,
e.g. if another UPS compatible with apcupsd is connected, we refer to the apcupsd documentation:

http://www.apcupsd.org

9.3 Advanced configuration

Things beyond that can be changed in the project and robot files.
The access to the configuration files of a robot with integrated controller is possible via "File" → "Ac-
cess Remote Configuration".

,
Do not change the configuration files unless you know what you are doing. Test the
robot at slow speed, as it may behave unexpectedly, move too fast or collide if the con-
figuration is incorrect.
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10 Modbus

The Modbus TCP protocol enables the control and retrieval of configuration and status information
from TinyCtrl-based integrated robot controllers. This allows robots to be easily controlled by pro-
grammable logic controllers (PLCs) and integrated into processes with other devices.

10.1 Licensing

The use of the Modbus functions requires a license. The functions can be used freely for test pur-
poses for 30 minutes, after which another test period can be started by restarting the controller. The
installation of a license file is described in the iRC documentation. Further information is available at

https://shop.cpr-robots.com/?product=modbus-tcp-
ip-schnittstelle

10.2 Configuration of the Modbus Server

The Modbus server can be configured via the configuration area in iRC. To do this, connect iRC to the
robot and open the Modbus configuration (file → Interface configuration → Modbus). The Modbus
server becomes active when the "Active" box is checked and "Apply" or "Save Project" is clicked. If
required, the port (default: 502) and the maximum number of connections can be changed.

10.3 TIA-Portal Library

For the implementation of the PLC side with a S7-1200 or S7-1500 CPU a library is available to the
user. The library contains data types and communication blocks. The download of the library can be
done via the following link.

https://wiki.cpr-robots.com/index.php/Modbus_Ser
ver

For including the library please contact the Siemens support.

https://support.industry.siemens.com/cs/ww/de/vi
ew/37364723

10.3.1 Creating the Robot Data Block

At first the insertion of a robot data block of type "CPR_ROBOT_MODBUS" is started. This data block
contains all important information and help for the later communication with the robot. The follow-
ing figure shows the robot data type. In the first place it contains a "TCON_IP_v4" object. This object
can be used to set the IP address of the robot and the port to use. The connection ID can also be set.
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If you have not changed the IP address of your robot, the corresponding addresses are already entered
in the default values. In the structure Data all entries from the Modbus mapping are accessible.

ð
Nomenclature
All data to send to the robot are marked with CMD or OUT. All data, from the robot
to the controller, are marked with Info or IN.

10.3.2 Inserting the Robot Communication FB

The FB CPR_Robot is responsible for communication with the robot. This function block requires the
following input signals.

Signal Data Type Explanation

Request_MB Bool Retrieve data from the robot. As long as this input is
set, the FB maintains active communication with the
robot.

Disconnect_MB Bool Disconnects the TCP/IP connection with the robot,
can be used for resetting errors

Reset Bool Resets the robot

Enable Bool Enables the robot

Reference Bool References all robot joints

StartProgram Bool Starts the robot program

StopProgram Bool Stops the robot program

Robot_Data CPR_ROBOT_MODBUS In/Out for the robot data block

The Robot_Data input provides the function block with all the data it needs to communicate with the
robot. By using several data blocks and CPR_Robot FB’s it is possible to communicate with several
robots at the same time. The following signals are available as outputs.

Signal Data Type Explanation

Enabled Bool Robot is enabled

Referenced Bool Robot is referenced

ProgrammRunning Bool The robot program is running

10.3.3 Data Access

To access the robot data, the data in the robot DB can be manipulated. These are then automatically
transferred to the robot and processed.
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10.4 Address Mapping

This section describes the address allocation to allow own implementations and extensions of the
PLC function blocks.
Modbus defines four memory areas that can be read and written by different messages. In the address
mapping of the igus robots, the areas are used as follows. In some cases information can be retrieved
both bitwise and as register.

Memory Section Access Usage

Coils 1 Bit, read and write Actions and changeable states

Discrete Inputs 1 Bit, read only States, information

Holding Registers 16 Bit, read and write Changeable values and states

Input Registers 16 Bit, read only Not changeable values, information

Table 23: Use of the Modbus address sections

The following Modbus function codes can be used to read and write the memory areas.

Memory Section Read Write

Coils 1 5 (single), 15 (multiple)

Discrete Inputs 2 -

Holding Registers 3 6 (single), 16 (multiple), 22 (masked), 23 (read and write)

Input Registers 4 -

Table 24: Supported Modbus function codes (decimal)

Since Modbus defines only 1-bit and 16-bit access, complex data types and actions are defined here
as follows:

Data Type Description

boolean Writing bit "0" or "1" starts the corresponding action or sets the state.

enum Enumeration. Meaning depends on the register, see section 10.4.5.

Info Information, not writable

int32 / uint32 Two 16-bit registers, least significant register first.

rising edge Action is executed when first a 0 and then a 1 is written. Attention: Some coils
return the actual value when reading, not the last written one. In case of double
assignment (e.g. enable/disable motors) the action is chosen depending on the
actual state.

string character string. Two 8-bit characters per register, least significant byte first.
The string ends with a zero byte or when the maximum number of registers is
reached.

Table 25: Definition of complex data types
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�
Position values (X, Y, Z, A, B, C, joint angles) are given as 32 bit values where necessary
and therefore occupy 2 registers. The first register contains the lower bits, the second
register the upper bits. For negative values both registers must be set accordingly.
The following link shows an example on how to calculate these values and move the
robot to a target position.

https://wiki.cpr-robots.com/index.php/Moving_Rob
ots_via_Modbus

The following tables describe the Modbus address assignment version 1 (see input register 3).

10.4.1 Coils and Discrete Inputs - 1 Bit, Read Only

Via coils and discrete inputs 1-bit accesses are possible. This is used here to query inputs and outputs
as well as simple states and to trigger actions.

ð
Read access to 1-bit data is possible both as coils and as discrete inputs so that fewer
Modbus messages have to be sent for reading both. Reading values that were previously
written as coil via discrete inputs should be avoided. Therefore it is recommended to
use only the coil access.

Addresses Type Description

10 Info Has robot axes

11 Info Has external axes

12 Info Has gripper axes

13 Info Has platform axes

14 Info Has digital input/output modules

20 Info Modules - No error

21 Info Module error - Temperature

22 Info Module error - Emergency stop / undervoltage

23 Info Module error - Motor not activated

24 Info Module error - communication

25 Info Module error - contouring error

26 Info Module error - encoder error

27 Info Module error - overcurrent

28 Info Module error - driver error

29 Info Module error - Bus dead

30 Info Module error - module dead

31-36 Info Module error - reserved for future errors

37 Info Kinematics - no error

38 Info Kinematics - axis limit min
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Addresses Type Description

39 Info Kinematics - axis limit max

40 Info Kinematics - Central axis singularity

41 Info Kinematics - Out of range

42 Info Kinematics - wrist singularity

43 Info Kinematics - Virtual box reached

44 Info Kinematics - Movement not allowed

45-49 Info Kinematics - reserved for future errors

50 Is CAN bus connected? / Connect (1) / Disconnect (0) (Connect / Dis-
connect not possible with TinyCtrl)

51 Shutdown control computer

52 Robot reset

53 Are the motors active? / Enable motors (1) / Disable motors (0)

54 Info Normal operation (see operation mode, table 32)

60 Are all axes referenced? / reference

61-66 Is robot axis referenced? / reference

67-69 Is external axis referenced? / reference

70-72 Is gripper axis referenced? / reference

73 Set all axes to 0

100 Start MoveTo - cartesian

101 Start MoveTo - Cartesian relative base coordinates

102 Start MoveTo - Cartesian relative tool coordinates

103 Start MoveTo - joint movement

104 Start MoveTo - joint movement relative

110 Info Is Zero-Torque (manual guidance mode) available?

111 boolean Is Zero-Torque enabled? / enable (1) / disable (0)

112 Info Is the robot moving?

120 Info Is a robot program loaded?

121 Info Is a logic program loaded?

122 Is the robot program running? / start / continue

123 Is robot program paused? / pause

124 Is the robot program stopped? / stop

130 Select next directory entry

131 Select previous directory entry

132 Info Is the selected directory entry a program file

133 Load selected directory entry as robot program / open directory

134 Go to the base directory (.../Data/Programs)

135 Unload robot program

136 Unload logic program

200-299 boolean Global signals

300-363 boolean Digital outputs
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Addresses Type Description

364-427 Info Digital inputs

Table 26: Assignment of coils and discrete inputs

10.4.2 Input Registers - 16 Bit, Read Only

The input registers provide read access to configuration, status and statistical information. To convert
numerical values into the correct unit, multiply by the factor specified under Unit. The meaning of
the state registers with data type enum is described in section 10.4.5.

Addresses Type Unit Description

0 uint16 Software ID (902=iRC, 980=TinyCtrl)

1 uint16 Software major version (e.g. 12)

2 uint16 Software minor version (e.g. 6)

3 uint16 Modbus mapping version

4-5 uint32 minutes Uptime complete

6-7 uint32 minutes Uptime last

8-9 uint32 minutes Uptime enabled

10-11 uint32 minutes Uptime movement

12 uint16 Program starts

13 uint16 0.1ms Cycle time target

14 uint16 0.1ms Cycle time max (last 50 cycles)

15 uint16 0.01Hz Cycle frequency (average)

16 uint16 0.01% Workload

20 uint16 Number of robot axes

21 uint16 Number of external axes

22 uint16 Number of gripper axes

23 uint16 Number of platform axes

24 uint16 Number of input/output modules

25-30 bit field Module error codes robot axes

31-33 Bit field Module error codes external axes

34-36 bit field module error codes gripper axes

37-40 bit field module error codes platform axes

41-43 bit field module error codes input/output modules

44-49 int16 0.1°C Temperature electronics robot axes

50-52 int16 0.1°C Temperature electronics external axes

53-55 int16 0.1°C Temperature electronics gripper axes

56-59 int16 0.1°C Temperature electronics platform axes

60-65 int16 0.1°C Temperature motors robot axes

66-68 int16 0.1°C Temperature motors external axes

69-71 int16 0.1°C Temperature motors gripper axes

72-75 int16 0.1°C Temperature motors platform axes
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Addresses Type Unit Description

76-81 uint16 mA Currents robot axes

82-84 uint16 mA Currents external axes

85-87 uint16 mA Currents gripper axes

88-91 uint16 mA Currents platform axes

92 uint16 0.01V Voltage

93 uint16 mA Total Current

94 uint16 0.1% Battery charge (not in TinyCtrl)

95 uint16 enum Kinematics - error code

96 uint16 enum Operating mode

130-135 int32 0.01mm Current Cartesian position

136-141 int16 0.01° Actual cartesian orientation

142-153 int32 0.01 Actual robot axis position

154-159 int32 0.01 Actual axis position ext. axes

160-165 int32 0.01 Actual axis position of gripper axes

166-173 int32 0.01 Actual axis position platform

262 uint16 Number of loaded robot programs

263 int16 Number of current program, 0 for main program

264 uint16 Number of instructions in current program

265 int16 Number of current instruction, -1 if program is not running

266 enum Reason for last program stop or pause

331 uint16 Number of entries in current directory

333-364 string Name of the selected directory entry

365-396 string Name of the current directory

207-210 bit field Digital inputs

400-431 string Info/error message short (as on manual control unit)

440-455 int16 Number variables mb_num_r1 - mb_num_r16

456-711 int16 0.1 Position variables mb_pos_r1 - mb_pos_r16 (see sec. 10.4.4)

Table 27: Assignment of the Input Registers

10.4.3 Holding Registers - 16 Bit, Read and Write

Target positions and variables as well as the name of a program to be loaded can be written via the
holding registers.

Addresses Type Unit Description

130-135 int32 0.01mm Target position cartesian

136-141 int32 0.01° Target orientation cartesian

142-153 int32 0.01 Target position robot axes

154-159 int32 0.01 Target position external axes

174-177 int32 0.01mm Target position platform

178-179 int32 0.01° Target orientation platform
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Addresses Type Unit Description

180 int16 0.1 Velocity for MoveTo (percent or mm/s)

181-186 int32 0.1 Target velocity of ext. axes in velocity mode

187 uint16 0.01% Velocity override

188 enum Jog mode

260 enum Robot program RunState

261 enum Robot program Replay mode

267-298 string Name of loaded robot program / load on write

299-330 string Name of the loaded logic program / load on write

332 uint16 Number of the selected directory entry

200-206 bit field Global signals

207-210 bit field Digital outputs

440-455 int16 Number variables mn_num_w1 - mb_num_w16

456-711 int16 0.1 Position variables mb_pos_w1 - mb_pos_w16 (see sec.
10.4.4)

Table 28: Assignment of the Holding Registers

10.4.4 Number and Position Variables

For communication with robot and logic programs, predefined program variables can be used in
addition to the global signals. For this purpose, 16 readable and 16 writable number and position
variables are available in each case.

Name Type Access via Modbus

mb_num_r1 - mb_num_r16 Number variable read only (input register)

mb_num_w1 - mb_num_w16 Number variable read and write (holding register)

mb_pos_r1 - mb_pos_r16 Position variable read only (input register)

mb_pos_w1 - mb_pos_w16 Position variable read and write (holding register)

Table 29: Program variables for communication via Modbus

ð
When using the PLC function blocks, only use the writable variables to send values from
the PLC to the robot. Do not change these variables in the robot program, as they are
regularly overwritten by the PLC.

�
Unlike normal program variables, the Modbus variables are always available. No pro-
gram has to be started and the variables do not have to be declared with the store state-
ment.

Each number variable is mapped in a register. Since only integers are supported here, the robot pro-
gram must convert to the desired value range by multiplication or division if necessary (Math instruc-
tion).
Position variables consist of 16 registers each, whose values are specified in tenth precision:
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• 9 registers for robot and external axes (A1-A6, E1-E3).
• 3 registers for Cartesian position (X, Y, Z)
• 3 registers for Cartesian orientation (A, B, C)
• 1 register for selection of conversion type

According to the translation type, the kinematics converts from axis angles to Cartesian coordinates
or vice versa. This can be helpful if, for example, target positions are only available as coordinates,
but the robot is to move per joint instruction.

Value Meaning

0 No conversion, axis positions and Cartesian coordinates are taken over without any
change (default)

1 Cartesian coordinates and orientation are calculated from the axis positions

2 The axis positions are calculated from the Cartesian coordinates and orientation

Table 30: Conversion type

ð
Beachten Sie, dass möglicherweise nicht alle Positionen von der Kinematik erreicht
werden können. Prüfen Sie die Werte daher auf Plausibilität.

10.4.5 Meaning of Enumeration Values

The following tables describe the meaning of the enumeration values (enums).

Value Meaning

0 No error

13 Axis limit Min

14 Axis limit max

21 Central axis singularity

22 Out of range

23 Wrist singularity

30 Virtual box violated in X+

31 Virtual box violated in X-

32 Virtual box violated in Y+

33 Virtual box violated in Y-

34 Virtual box violated in Z+

35 Virtual box violated in Z-

50 NAN in calculation

90 Motion not allowed

65535 (0xFFFF) Unknown error

Table 31: Kinematic error code
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Value Meaning

0 Standard - normal operation

1 Serious error, control must be restarted

2 CAN-Bridge (CRI, e.g. retrieve firmware parameters)

Table 32: Operation mode

Value Meaning

0 Axes

1 Cartesian base coordinate system

2 Cartesian tool coordinates

3 Platform

0xFFFF Invalid

Table 33: Jog Mode

Value Meaning

0 Program is not running

1 Program is running

2 Program paused

Table 34: RunState

Value Meaning

0 Run program once

1 Repeat program

2 Execute instructions step by step

3 Fast (not used)

Table 35: Replay Mode

Value Meaning

0 User (Teach pendant, CRI, Modbus, etc.)

1 PLC

2 Program (stop/pause instruction)

3 Replay Step (step operation)

4 Shutdown (system shuts down)

100 Error

101 Path generator error 1

102 Path generator error 2

103 Error in state machine
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Value Meaning

Table 36: Reason for last stop/pause of program
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11 Maintenance

11.1 Cleaning

• After the control unit is disconnected from the mains, it can be wiped with a damp cloth.
• After the control unit is disconnected from the mains, fans or ventilation slots can be cleaned

carefully with a damp cloth or light compressed air. In doing so, the rotors of the fans must be
held firmly so that they do not receive bearing damage due to excessive speed (rpm).
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12 Troubleshooting

12.1 Frequently Asked Questions

Antworten zu häufig gestellten Fragen finden Sie in unserem Wiki:

https://wiki.cpr-robots.com

12.2 Error Codes and Solutions

Our troubleshooting guide provides step-by-step assistance in identifying and solving problems:

https://wiki.cpr-robots.com/index.php/Troublesho
oting

Error codes and problems with hardware and electronics are described in the following article:

https://wiki.cpr-robots.com/index.php/Robot_Har
dware_Troubleshooting

Solutions to common software problems are described in the following article:

https://wiki.cpr-robots.com/index.php/CPRog_Sof
tware_Troubleshooting

12.3 Test Software Module Control

The Module Control software can be used to test axes individually and without the influence of the
robot control. Among other things, it enables the axis to be moved and referenced, and parameters
to be read out and changed (see section 8.3).
Module Control can be downloaded under the following link. The operation is also described there
in more detail.

https://wiki.cpr-robots.com/index.php/Config_Sof
tware_ModuleCtrl
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12 TROUBLESHOOTING

12.4 Support Contact

If you have any problems, we will be happy to help!
• igus Support landingpage:

https://www.igus.eu/info/igus-low-cost-automatio
n

• E-Mail: ww-robot-control@igus.net

�
In case of software problems, please send us the log files of the iRC - igus Robot
Control and the integrated controller. To do this, simply click on the question
mark at the bottom right of the 3D area to automatically attach all relevant files
to an e-mail

• Telephone: +49(0)2203 / 96498-255
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